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To Use the Front Panel

You can use the dedicated, front-panel knobs and buttons to do the most commonly performed operations.

Use the multipurpose knobs to control
parameters selected from the screen interface.
Push a FINE button to make small changes with

a multipurpose knob.

Turn channel displays on and off, and adjust the
channel POSITION and SCALE using dedicated

knobs and buttons.

Use these buttons to start and stop
acquisition or start a single acquisition

sequence. The ARM, READY, and TRIG’D
lights show the acquisition status.

Push AUTOSET to quickly set the vertical,
horizontal, and trigger controls for a

usable display.

Push to turn the touch screen on and off.

Push DEFAULT SETUP to return settings to the
default values.

Push PRINT to make a hard copy.

Push FastAcq to turn Fast Acquisition
on and off.

Push ZOOM to add a magnified graticule to the
display. Push the HORIZ or VERT button to
select the axis that you want to magnify.

Use these knobs and buttons to set horizontal
SCALE and POSITION for the waveforms. Push
DELAY to turn on horizontal delay, and then use

POSITION to set the delay time. Adjust
RESOLUTION to change the number of acquired

points in the waveform.

Use these knobs and buttons to set the basic
trigger parameters. Push ADVANCED to display

a menu of additional trigger functions.
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Push CURSORS to turn cursors on and off.

Turn INTENSITY to adjust waveform intensity.



To Use the Screen Interface

Touch a numerical control to assign that control
to a multipurpose knob. Turn the multipurpose

knob to adjust the parameter value.

Touch a screen control to change a setting.

Touch here to change to
toolbar operation.

Or Choose the Menu Bar

Choose the Toolbar

Touch a button in the toolbar to display a
control window at the bottom of the display.

Use some menu items to
display a control window at the
bottom or side of the display.

Touch here to
change to menu-bar
operation.

Touch here to close a
control window.

You can control all oscilloscope functions except the power switch using only the screen interface.

Use some menu items to
directly change settings.

� Use the touch screen to control the oscilloscope when bench space is
unavailable, such as on a cart or in an equipment rack.

� Plug in a mouse and keyboard if you have the bench space to use them. You can
plug in a USB mouse or keyboard anytime, even while the oscilloscope is
running.

� Use the menu bar to access PC-related functions, such as Page Setup, Export,
and Copy.

More Operating Tips:



To Display a Waveform

Attach a probe to CH 1 and connect the probe
to your signal.

1

Push AUTOSET. 3

Adjust VERTICAL and HORIZONTAL
POSITION and SCALE if necessary to

optimize the display.

4

Push CH 1 if channel 1 is not
already displayed.

2

Adjust RESOLUTION to change the record
length and sample rate. You can acquire

more samples in the waveform to see more
detail or acquire fewer samples with a

faster update rate.

5 6
Adjust INTENSITY to change the
brightness, vector fill, and display
persistence of acquired points.

TDS7104
TDS7054

TDS7404
TDS7254
TDS7154

CSA7404
CSA7154

CH 1

CH 1

CH 1



To See More Waveform Detail

You can also set up a zoom graticule

from the screen interface. First touch and
drag across the segment of the waveform

that you want to see in greater detail.

3

1

Then select a zoom graticule mode from the
drop-down list to magnify the highlighted

waveform segment.

4

Use Horizontal Delay

Adjust the delay time with the horizontal

POSITION control, or enter the delay time
in the control window.

2

Adjust the horizontal SCALE to acquire

the detail you need around the delay
expansion point.

3

Use Zoom

Push the ZOOM button to display a
zoom graticule.

1

Use the Zoom function to magnify an acquisition vertically, horizontally, or in both
display dimensions. POSITION or FACTOR changes that you make to the Zoom
graticule affect only the zoom display, not the actual acquired waveform.

Use horizontal DELAY to acquire waveform detail in a region that is separated from
the trigger location by a significant interval of time.

Delay time

Trigger point
Acquired waveform

Expansion point
Push the front-panel DELAY button.

� You can use Zoom and Horizontal Delay together to magnify a delayed
acquisition.

� Toggle Horizontal Delay on and off to quickly compare signal details at two
different areas of interest, one near the trigger location and the other centered at
the delay time.

More Operating Tips:

Main graticule Zoom graticule

Push the HORIZ button or the VERT button to
select the axis you want to magnify in the zoom
graticule. Use the multipurpose knobs to adjust

the zoomed waveform’s position and
magnification factor.

2



1

To Use Fast Acquisition

Push the front-panel FastAcq button.

Or select Fast Acquisitions in the
Horiz/Acq menu.

2Adjust INTENSITY to optimize the intensity or
color grading for the signal you want to analyze.

Increasing intensity can make less-frequently
acquired points brighter in the display.

� Choose one of the color grading palettes in the Display Colors control window to
see different sample densities represented in different colors.

Turn Fast Acquisition on to acquire up to 400,000 waveforms per second.

� Turn AutoBright on in the Display Appearance control window. When you use
AutoBright, the displayed waveforms remain visible even at low trigger repetition
rates.

More Operating Tips:

How DPOs Work

Analog Real Time sweeps

Digital Storage acquisitions

Digital Phosphor acquisitions

Unlike DSOs that have long dead times
between acquisitions, Digital Phosphor

Oscilloscopes (DPOs) continuously acquire
waveforms at rates comparable to analog

oscilloscopes. In Fast Acquisition mode, DPOs
continuously overlay the acquired information

into a three-dimensional database that is
updated on the display 30 times per second.
For each pixel in the display, the intensity (or

color) of the pixel is proportional to the
number of actual samples that the pixel

represents.



For Average or Envelope acquisition modes,
touch the # of Wfms control and then set the
number of waveforms with the multipurpose
knob. You can also double-touch the control

and use the pop-up keypad.

To Choose an Acquisition Mode

1

2

Select Acquisition Mode... in the
Horiz/Acq menu.

Or touch the Horiz button, and then
select an acquisition mode in the

horizontal/acquisition control window.

How the Acquisition
Modes Work

Displayed record points (at
maximum horizontal magnification)

Peak Detect

Interval 1 2 3 4 Interval 1 2 3 4

Sample

Average mode calculates the average value for
each record point over many acquisitions.

Average uses Sample mode for each individual
acquisition.

Envelope

Average

Acquisition 1 2 3

Three acquisitions from one source

Envelope mode finds highest and lowest record
points over many acquisitions. Envelope uses
Peak Detect for each individual acquisition.

Sample mode retains one sampled point from
each acquisition interval.

acquisition interval =
record duration

number of points in record

Peak Detect mode uses the highest and
lowest of all the samples contained in two

consecutive acquisition intervals.

Hi Res mode calculates the average of all
the samples for each acquisition interval. Hi Res

Waveform Data Base mode takes an ensemble
of acquisitions that is best for accurate eye

pattern measurements.
WfmDB

Max
MinMin

Max



To Select a Trigger

You can also select a trigger type in the
Trigger menu.

Or touch the Trig button and then select a
trigger type in the trigger control window

that is displayed.

Trigger Selections

Trigger type Levels Trigger conditions

Edge

Glitch

Width

Runt

Timeout

Transition

Setup/Hold

Pattern

State

Single level

Single level

Single level

Two levels to define the
logic transition region

Single level

Two levels to define the
logic transition region

Independent levels for
Data and Clock

Independent levels for
each channel

Independent levels for
each channel

Trigger on rising or falling edge, as defined by slope
control. Coupling choices are DC, AC, AC LF Reject, AC
HF Reject, and Noise Reject.

Trigger on glitches narrower than the specified width or
ignore glitches narrower than the specified width.

Trigger on pulses that have widths between the range of
the two timers or outside the range of the two timers.

Trigger on a pulse that enters the transition region from
one side but does not leave the region from the other side.

Trigger when a signal does not make a transition for a
specified length of time.

Trigger when a logic signal spends more time or less time
in the transition region than a specified amount of time.

Trigger on violations of setup or hold time between a Data
signal and a Clock signal. The specified setup and hold
times can be positive or negative values.

Trigger when a Boolean combination of up to four
channels becomes true. Trigger immediately or only after
the combination is true for a specified time duration.

Trigger on transition of one channel when a Boolean
combination of up to three other channels is true.

Timers

None

One to specify glitch
width

Two to specify minimum
and maximum pulse
widths

One to specify an
optional minimum
runt-pulse duration

One to specify time-out
time

One to specify transition
time

One to specify setup
time and one to specify
hold time

One to specify pattern
duration

None

Select the EDGE trigger type and then set the
source, coupling, slope and mode with these

front-panel controls. Push ADVANCED to select
one of the other trigger types.

Comm

Serial

Depends on Coding Trigger on telecom signals. Optional on TDS7000 series.None

Single level plus clock
and bit pattern

Trigger on serial pattern data.
Optional on TDS7000 series (not available on TDS7104 or
TDS7054).

None



To Use the A (Main) and B (Delayed) Triggers

B trigger point

Trigger
delay time

Waiting for nth
event (Where n=5)

Trigger on B Event

A trigger
source

B trigger
source

A trigger
source

B trigger
source

B Trigger After Delay Time

Acquired waveform recordA trigger point

A trigger point

You can use the A Event (Main) trigger alone or combine it with the B Event (Delayed) trigger to capture more complex signals.

B trigger point

Pretrigger
record

Posttrigger
record

� B-trigger delay time and horizontal delay time are independent functions. When
you establish a trigger condition using either the A trigger alone or the A and B
triggers together, you can also use horizontal delay to delay the acquisition by an
additional amount.

� When using the B trigger, the A trigger can be any of the following types: Edge,
Glitch, Width, or Timeout. The B trigger type is always Edge type.

More Operating Tips:

The A trigger arms the oscilloscope.
Posttrigger acquisition starts on nth B event.

The A trigger arms the oscilloscope.
Posttrigger acquisition starts on the first B

edge after the trigger delay time.

1Set the A trigger type and source in
the A Event (Main) tab of the trigger

control window.

2Choose a function in the A→B Sequence tab of
the trigger control window.

4Set the B trigger characteristics in the B Event
(Delayed) tab of the trigger control window.

Set the trigger delay time or the number
of B events, as appropriate.

3



Select Mask Setup in the mask menu.

To Perform Mask Testing
(standard on CSA7000, optional on TDS7000 series)

1
Choose a mask type.

Choose a mask standard.

2

3

Select Autoset to automatically set up the
controls based on the input signal.

Use the Source tab to select the source of
your signal.

4

Optionally select Autofit to align each
acquired signal with the mask to minimize the

number of hits.

5

Use the Tolerance tab to increase or decrease
the mask margin used in mask testing.



To Setup Mask Pass/Fail Testing and View Results
(standard on CSA7000, optional on TDS7000 series)

Use the Pass/Fail Setup tab to setup Pass/Fail
testing.

1

Use the Pass/Fail controls to start, stop, or
continuously run a mask test.

2

Use the Polarity controls to select testing the
positive, negative, or both the positive and

negative pulses.

3

Enter the number of waveforms to acquire and
use in your mask test.

4

Enter the number of waveforms that must fail to
consider the test a failure.

5

Enter the time that the instrument delays before
starting the mask test.

6

Use the Pass/Fail Test Notification controls
to select how you want to be notified when

a failure occurs and when the
mask test completes.

Use the Pass/Fail Results tab to view the
results of your mask testing.

When using masks that enable the Waveform Database mode, the
# of Wfms field changes to # of Samples field.



Or choose a measurement for the selected
waveform directly in the Measure menu.

To Take Automated Measurements

Touch the Meas button, and then select up to
eight measurements using the measurement

control window.

Cycle Area

Area

Cycle
RMS

RMS

Mean

Negative
Overshoot

Positive
Overshoot

Amplitude

Pk--Pk

Max

Low

High

Burst
Width

Phase
Negative
Duty Cycle

Positive
Duty Cycle

Fall Time

Rise Time

Negative
Width

Positive
Width

Frequency

Period Delay

Min

Cycle
Mean

Automated Measurement Selections

Amplitude Time More Histogram

Wfm
Count

Hits in
Box

Peak
Hits

Median Mean

Pk--Pk

Min

� ± 1σ

Std Deviation

Max

� ± 2σ

� ± 3σ

Use the tabs to access measurements by
category.

Ext Ratio %

Comm
(optional on TDS7000 series)

ExtRatio

Ext Ratio (dB)

Jitter RMS

Jitter P-P

Jitter 6σ

Eye Height

Eye Width

Crossing %

Noise P-P

Noise RMS

S/N Ratio

Eye Top

Eye Base

Cyc Distortion

Q-Factor



To Customize an Automated Measurement

Use Gating to confine the measurement
to a certain portion of the waveform.

Turn on measurement statistics to
characterize the stability of the measurement.

Adjust the measurement reference levels to
different relative or different fixed values.

Select snapshot to see a one-time view of
all valid Normal or Comm measurements.

To Set Up a Histogram

Touch and drag across the segment of the
waveform that you want the histogram to cover.
To set up a horizontal histogram, for example,

make the box wider than it is tall.

If you need to make any adjustments
to the histogram, use the histogram

setup control window.

1

Select Histogram Horizontal from the
drop-down list.

2

View the histogram at the top or edge of
the graticule.

3

4

Take automated measurements on histogram
data. See previous page for information.

5



To Take Measurements With Cursors

� You can set the cursors to move together in tandem if you choose the Tracking
cursor mode. The cursors move independently if you choose the Independent
cursor mode.

� If you use the zoom graticule, you can place a cursor directly on a specific
waveform point to take precision measurements.

� You can also move cursors by touching or clicking them and then dragging them
to a new position.

Other Cursor Measurement Tips:

Select the waveform you want to measure and
a cursor type in the cursor control window.

Or you can activate cursors on the selected
waveform directly in the Cursor menu.

If you choose split cursors to take
measurements between waveforms,

select the source for each cursor. T1: 356.4 ms
T2: 352.5 ms
∆T: 3.92 ms
1/∆T: 255 Hz
V1: 5.120 V
V2: 4.886 V
∆V: 234 mV
∆V/∆T: 59.7 V/s

1

2

4

Read cursor measurement
results in the display.

5

Push the front-panel CURSORS button.

Place cursors with the multipurpose knobs
or enter the cursor locations numerically.

3



To Use Math Waveforms

Choose Spectral Analysis to define FFT
magnitude and phase waveforms. When an
FFT waveform is selected, you can use the

multipurpose knobs to adjust the FFT waveform
just as you would using a spectrum analyzer.

Select Math Setup in the Math menu.

To Use Spectral Analysis

Choose one of the predefined math equations.

Adjust FFT center
frequency

Adjust FFT span

You can view time-domain and
frequency-domain waveforms

simultaneously. You can also use
gating to select only a portion of the
time-domain waveform for spectral

analysis.

1

2

Or touch Editor to define a more advanced
math waveform. Then build the waveform

expression using sources, operators, constants,
measurements, and functions.



To Store Information

To Save and Recall Waveforms
To save or recall waveforms, select

Reference Waveforms and then Save Wfm... or
Recall Wfm... in the File menu.

Or touch the Refs button.

1

Use the reference setup control window to copy
a live waveform into one of four nonvolatile

reference waveform storage locations. You can
also display these waveforms as reference

waveforms.

To Save and Recall Instrument
Setups

To save an instrument setup, select
Instrument Setup in the File menu.

Or touch the Setups button.

2

Use the settings control window to save the
current setup into one of ten internal storage

locations. Use the pop-up keyboard to label the
setups for easy identification.

Or select Save Settings to File to store the
current setup on a disk drive. You can recall any

setup stored on disk and then save it in an
internal setup storage location for

quicker access.

1

2

To restore the oscilloscope to a known initial state,
push the front-panel DEFAULT SETUP button.

Or select Recall Default Setup in the File menu.

3

3Select Save Wfm to File to store the live
waveform as a file on a disk drive. You can
recall a waveform stored on disk into one

of the internal reference waveform
locations for display.



To Copy or Export Your Results

You can export waveform data into a comma-
separated ACSII file for use in a spreadsheet or

data analysis program. Select Export Setup in the
File menu to set the output content and format

for images, waveforms, or measurements.

To print a hard copy to an attached printer or a
network printer, push the front-panel PRINT

button.

Or select Print in the File menu. If necessary,
you can make changes to the page orientation

in the Page Setup dialog box.

To Print a Hard Copy

You can use the Windows clipboard to
copy information. Simply select the item
to copy, copy it, and then paste it into

another Windows application.

The Page Setup dialog box also includes
selectors for the print palette and a feature
called Ink Saver. Ink Saver optimizes the

display colors and shades for printing hard
copies on white paper.



To Run Application Software
You can install and run optional application software on your oscilloscope. These software packages provide advanced capability
supporting many applications. Two examples are shown below; additional packages may be available. Contact your Tektronix
representative for more information.

Follow the instructions provided with the
application software to install it. To run

the software, select the application in the
File / Run Application menu.

Use TDSDDM Disk Drive Measurement
Software to measure disk drive signals

according to IDEMA standards.

Use TDSJIT Jitter Analysis Software to
characterize timing performance. Analyze

jitter on contiguous clock cycles using
single-shot acquisitions.



To Connect to a Network

Like any other Windows computer, you can
connect the oscilloscope to a network to enable
printing, file sharing, internet access, and other

communications functions.

To make a network connection, consult with
your network administrator, and then use the
standard Windows utilities to configure the

oscilloscope for compatibility with your network.

To Use a Dual Monitor

Connect a keyboard, mouse, and monitor to
the oscilloscope and configure Windows for

dual-monitor mode. You can operate the
oscilloscope while having full use of

Windows and other installed applications on
the external monitor.

Connect the monitor to the upper SVGA port
on the oscilloscope rear panel. Use the

Settings tab in the Windows Display
Properties dialog box to set up a

dual-monitor configuration.

Network



To Access the Help System

Touch the HELP button or select Help on
Window in the Help menu to receive

context-sensitive help on the current setup.

Select Contents and Index in the Help menu to
access any topic in the help system. Select the
topic, and then touch the Display button in the

dialog box.

Touch an outlined control shown in the help
window to receive more specific information

about the control.

Touch a tab in a help window to navigate
between the Overview and specific topics.

Touch the Minimize button in a help window
to move help out of the way so you can

operate the oscilloscope. Touch the Restore
Help button to see the last help topic again.



Front Panel Inputs and Outputs

Floppy disk drive accessible
from Windows

Ground terminal

Channel inputs

Recovered clock output

Recovered data output

Optical input to O/E converter

Probe compensator output to compensate
and deskew probes

Electrical output from O/E converter

CSA7404
CSA7154

Floppy disk drive accessible
from Windows

TDS7404
TDS7254
TDS7154

Ground terminal

Channel inputs

Auxiliary input to provide an external
trigger input

Auxiliary output to provide trigger
output signal

Analog signal output from the CH 3 input

Probe compensator output to compensate
and deskew probes

Floppy disk drive accessible
from Windows

TDS7104
TDS7054

Ground terminal

Channel inputs

Auxiliary input to provide
an external trigger input

Auxiliary output provides trigger
output signal

Analog signal output from the CH 3 input

Probe compensator output to
compensate and deskew probes.



Connectors for speaker and microphone

RJ-45 connector to connect to network

Rear Panel Inputs and Outputs

Removable hard disk drive to provide
individual environment for each user or to

secure data; press cover to release the disk

USB connector for mouse, keyboard, or other
peripherals

COM1 serial port

Upper SVGA port to connect a monitor for
dual-monitor operation

Lower VGA port to replicate the oscilloscope display
on an external monitor

PS-2 connectors for mouse and keyboard

Parallel port (Centronics) to
connect printer or other device

GPIB port to connect to controller

CD drive accessible from Windows; press
cover to open the drive

CSA7000 only: Auxiliary (external trigger) input,
Auxiliary (trigger) output signal,

Analog (CH 3) signal output

External reference input and
internal reference output



P7240 4 GHz Active Probe for
general-purpose applications

TCA-SMA, TCA-BNC 50Ω, and TCA-N
adapters for your probes and cables

P7330 Differential Probe for differential-
signal and low-noise applications

Recommended Probes and Accessories

P6139A Passive Probes for
general-purpose applications

P6243 and P6245 Active Probes or P6158
Low-C Probe for high-speed applications

P6247 and P6248 Differential Probes for
differential signals and low-noise applications

TCP202 Current Probe for
general-purpose applications

CSA7404, CSA7154
TDS7404, TDS7254, TDS7154

TDS7104, TDS7054

P7260 6 GHz 5x/25x Active
Probe

TCA-1MEG Buffer Amplifier to connect
1 MΩ accessories


